Contents

Chapter 1  Introduction 5
  Support ..........................................................................................................................................................5
  Typographical Conventions ..........................................................................................................................6

Chapter 2  Overview 7
  Working With List Editors ............................................................................................................................9
  Where Are The Files ...................................................................................................................................12

Getting Started 12
  Show Seasons .............................................................................................................................................18
  Show Types .................................................................................................................................................20
  Divisions .....................................................................................................................................................22
  Sections .......................................................................................................................................................24
  Locations .....................................................................................................................................................26
  Member Types ............................................................................................................................................27
  Categories ...................................................................................................................................................28
  Ratings ........................................................................................................................................................29
  Points Tables ...............................................................................................................................................30
  Medal Qualification ....................................................................................................................................35
  Points System ..............................................................................................................................................37
  High Points ................................................................................................................................................44
  Mailing Lists ...............................................................................................................................................47
  Trainers .......................................................................................................................................................49
  Edit Defined Names ....................................................................................................................................53

Chapter 3  The Members Screen 55
  Members Screen Features ...........................................................................................................................58
  The Members Menu ....................................................................................................................................62

Chapter 4  The Horses Screen 65
  Horses Screen Features ...............................................................................................................................67
  The Horses Menu .......................................................................................................................................71

Chapter 5  Searching For Member And Horses 73

Chapter 6  Creating a Show 75
  Using the Create Show Page .......................................................................................................................79
## Chapter 7 The Points Screen 83

- Using The Points Screen ................................................................. 85
- Using Update Show Points/Refresh Points ........................................ 94
- Class Judges ................................................................................... 97

## Chapter 8 Reports 99

### RSMH Server 100

- Configuring Web Upload ................................................................. 101
- Uploading RSMH Data ................................................................. 102
- Upload Management ................................................................. 104
- Uploading Org data ..................................................................... 106
- Downloading Org Data ................................................................. 107

## Chapter 9 Email 109

- Email Tool .................................................................................. 110
- Sending Bulk Emails ................................................................. 111

## Calendar Editor 115

## Chapter 10 Labels and Cards 121

- Member and Recording Cards ..................................................... 123
- Mailing Labels ........................................................................... 126

## Chapter 11 Import/Export 129

- Exporting Organization Data ..................................................... 130
- Importing Show Data ................................................................. 132
- Importing Joined At Show ........................................................ 133
- Importing USEF Results .......................................................... 136
- USEF Name Mapping Tokens .................................................... 139

## Chapter 12 Registering OrgPro 141

## Index 143

Copyright © 2000-2018 Sport Data, Inc.
All rights reserved
The software contains proprietary information of Sport Data, Inc; it is provided under a license agreement containing restrictions on use and disclosure and is also protected by copyright law. Reverse engineering of the software is prohibited.

Due to continued product development this information may change without notice. The information and intellectual property contained herein is confidential between Sport Data, Inc and the customer and remains the exclusive property of Sport Data, Inc. If you find any problems in the documentation, please report them to us in writing. Sport Data, Inc does not warrant that this document is error-free.

No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, mechanical, photocopying, recording or otherwise without the prior written permission of Sport Data, Inc.

OrgPro™ is a trademark of Sport Data, Inc
OrgPro™ has been designed to provide total membership and points management for organizations that sanction horse shows. We have attempted to create a program that is easy for a person with minimal computer training to learn and use yet powerful enough for any requirement.

OrgPro provides web reporting of results, standings, and member and horse show records with the optional RSMH Server, bulk emailing to membership, mailing labels, and the reports that organizations need to operate.

In This Chapter

Support .................................................................5
Typographical Conventions ............................................6

Support

This users guide will help you learn to use OrgPro™. The program has been designed to be easy to learn and use, yet powerful enough for the most demanding situation.

If you have questions, or need more information, please feel free to contact us by email at info@sportdatainc.com or visit our website at http://www.sportdatainc.com.

We can be reached by telephone at (734) 667-3390. Our fax number is (734) 667-3391.
Typographical Conventions

Before you start using this guide, it is important to understand the terms and typographical conventions used in the documentation.

For more information on specialized terms used in the documentation, see the Glossary at the end of this document.

The following kinds of formatting in the text identify special information.

<table>
<thead>
<tr>
<th>Formatting convention</th>
<th>Type of Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Triangular Bullet(➢)</td>
<td>Step-by-step procedures. You can follow these instructions to complete a specific task.</td>
</tr>
<tr>
<td><strong>Special Bold</strong></td>
<td>Items you must select, such as menu options, command buttons, or items in a list.</td>
</tr>
<tr>
<td><em>Emphasis</em></td>
<td>Use to emphasize the importance of a point or for variable expressions such as parameters.</td>
</tr>
<tr>
<td><strong>CAPITALS</strong></td>
<td>Names of keys on the keyboard. for example, SHIFT, CTRL, or ALT.</td>
</tr>
<tr>
<td>KEY+KEY</td>
<td>Key combinations for which the user must press and hold down one key and then press another, for example, CTRL+P, or ALT+F4.</td>
</tr>
</tbody>
</table>
Before starting to learn the specifics of OrgPro it will be beneficial to learn about its general capabilities. These capabilities fall into several categories:

**Membership Management**
- Records and maintains the basic membership information.
- Provides mailing list management.
- Produces membership cards and/or E-Cards (with RSMH Server option)
- Produces member points reports
- Tracks payment of membership fee

**Horse Management**
- Records and maintains the basic horse information
- Produces recording cards and/or E-Cards (with RSMH Server option)
- Produces horse points reports
- Tracks payment of recording fee

**Points Management**
- Maintains points for all recognized sections
- Supports increment tables by name
- Supports increment tables by division/rating
- Supports number placed over + 1.
- Supports one point per dollar won
- Points can be awarded to show champions and reserve champions
- Publishes result, standings, members, and horses to web site.
- Prints section standings reports
OrgPro is compatible with ShowPro. With a few clicks of the mouse, results can be imported from ShowPro. These results and the updated section standings can be generated to your web site within minutes. You can also create a show within OrgPro and assign points manually.

OrgPro supports sub shows and multiple judges for non Hunter Jumper disciplines, these will import in from ShowPro or can be entered manually.

In This Chapter

Working With List Editors .................................................9
Where Are The Files ..........................................................12
Working With List Editors

Much of the data in any software program consists of simple lists of items. To provide a consistent interface for managing these lists of items ShowPro uses List Editors like the one shown to the left.

As you configure OrgPro here and there to get your desired outcomes you will be using at times List Editors such as the Locations shown here which in OrgPro is available on the Data menu.

The List Editor has a list at the top and an edit box at the bottom where you can edit the item that is selected in the list at the top.

There may be special features, this one has buttons to allow you to change the order of the items.

Use the New button to add an item to the list.

Use the Delete button to remove an item from the list.

To add a new item to the list click New. A "New Whatever" item will be added to the list.

Now edit the text in the edit box at the bottom.
Notice that as you type in the edit box the text in the list for the selected item is changing along with the text in the edit box.

To add additional items to the list just click New and repeat the process.

When you are done adding items click Close, they will be saved automatically.

If you add too many items by accident please be sure and delete them before closing the box. Better yet, don't click New until you're sure you need another item and have it in your mind what the text for that item will be.

But in any case don't leave your list in a state where it basically has garbage in it.
Don't put a blank item in your list either intentionally or accidently. If you get a blank item type some legitimate text into it or delete it.
Where Are The Files

OrgPro saves just about everything that gets stored to disk by default in a My OrgPro Files folder. This folder resides in your My Documents folder.

There is an item on the File menu that will open this folder to make it convenient to access your files.

Getting Started
To start using OrgPro to manage your organizations members and horses and the points that they are awarded you first have to do the initial setup of your organization. This is not difficult and only involves a few steps. Some of the items you need to setup rely on other items so there is a particular order that should be followed in your initial setup.

In general what you should do is start at the top of the Data menu and work your way down. A starter organization and show season will already have been created for you as they are needed to open OrgPro, you should edit these items to suit your actual organization.

The first time you select Organization from the data menu the following dialog box will be displayed...
Edit the name of the organization, it's state abbreviation, and it's acronym to suit for your actual organization.

There are several options for determining eligibility for horses and riders to receive points.

Set the months that are used to establish the age of people and horses.

Categories allow you to have parallel sets of standings such as Local and Regular for example. They can member/horse or show based. This is an advanced function that you should probably discuss with us before using, if you're not sure whether you should check the Use categories box don't check it.

OrgPro can assign membership and recording numbers automatically or you may manually enter your existing numbers.

You can use national numbers such as USEF for your numbers, we don't actually recommend this but you can do it.

If you have existing data from another program that needs to be converted, contact us; we may be able to help.
Your completed organization will look something like this.

This organization uses show based categories.

They have the optional RSMH Server.

The next item you need to work on is your **Show Season**, it also has been created for you and you just need to edit it.
Setting up your organization properly is very important because you are deciding what your horse shows will consist of for the entire season. You are much better off taking your time, doing the proper planning, and making sure that this job gets done right. If you have questions don't hesitate to contact us.

This is what you have to do to set up your organization, and why:

You must define at least one Show Type. OrgPro allows an organization to have multiple show types and points are maintained separately for each one. It's desirable to have one show type, but if you will be hosting shows that fall into different categories, with different championships, it is important that you create a show type for each one. For example you may have:

- Regular member
- C Circuit
- Pony

You may need to define Categories. Some organizations offer separate championships for the same section depending on some criteria, usually geographical, like Local or Regional. OrgPro provides support for this with Categories. If you think you need these you should talk to us about it, you may only need one show type and no categories but otherwise getting the right mix of show types and categories can be tricky.

You must define a Show Season. This keeps your horse shows for a season grouped together so that championships can be determined. It is simply a matter of assigning a name, such as MYHJA 2015, and specifying the ending date of the season.

If your discipline is other than Hunter Jumper you must define the Divisions that you will have. As far as OrgPro is concerned Divisions are just a grouping of sections. In Hunter Jumper the divisions are predetermined.

You must define the Sections that you will be maintaining points for in each divisions, a section is a set of end of year standings, you will have a set of standings for each section that you create. This is not difficult but it is very important that this is done correctly. It is important that you only include sections that you will award a championship for at the end of the show season. Each Section that you define will be associated with a Division which will in turn be associated with a Show Type.

You must define your organizations Member Types. These are the different categories of members that you will have such as Junior, Amateur, and Professional. This member type will be printed on the membership card. OrgPro has a built in Non Member member type that cannot be modified.

You are not required to but you will certainly want to set up Mailing List categories. This will enable you to generate mailing lists for various purposes such as prize lists or newsletters. The mailing lists are used for generating mailing labels and also for bulk emailing.

You must define at least one Location. You may have one or many locations. This is where the horse shows are held. Depending on your circumstances the location may not be a physical location, it could be a region or zone for example.

To summarize, OrgPro has a set of parameters that define how your organization works. If your organization is straightforward (some are believe it or not!) then setting the parameters will be very straightforward as well, otherwise there is a lot of flexibility in these parameters and many organizations with very different requirements have been accommodated. Feel free to contact us to discuss your particular needs, we are happy to help you configure your OrgPro.
Show Seasons

Show Seasons allow memberships, recordings, and points to be maintained for a unit of time. Each show year you will create a new show season. All your members and horses will be carried forward into subsequent show seasons with their paid status cleared so that you can begin tracking this for the new season.

Initially OrgPro creates a show season for you that should be edited to match your organization.

When you select Show Seasons from the Data menu and the following dialog will appear...

This is showing the initial show season that OrgPro created for you, you want to edit this to suit your organization.

Type over the name using your organizations acronym and the year of the show season.

Set the start date and end date of the show season.

It should look something like this when you're done editing.

The Concluded check box prevents you from uploading data from a show season before you intended to, OrgPro will not let you upload from a show season unless the previous show season is marked as concluded.

Click Close and you're done.
At the beginning of each show year you will need to create a new show season. To do this just click **New** and a "New Show Season" will be added to the list. Then just edit the name using your acronym and the new show year and set the start and end dates.

Once you have multiple Show Seasons a menu item will appear on the **File** menu allowing you to switch between them.
Show Types

Show Types are just categories of point keeping basically. Some organizations sanction different types or categories of shows and Show Types just keep the points management logically organized and presented.

Most organizations will only need one Show Type, some may have several.

To define your Show Types select **Show Types** from the **Data** menu and the following dialog will appear...

This form of dialog box called a **list editor** (see "Working With List Editors" on page 9) is used frequently in OrgPro to give names to the various items that define your organization.

To add an item, click the **New** button and a new item will be added to the box. If you click on that item in the box, it will appear in the edit box below. You can then edit the text.

To add a **Show Type**, click the **New** button:

A "New Show Type" will be added to the box. You may now edit the text in the box below.

Add as many **Show Types** as you will be maintaining points for:
This organization will be maintaining points and awarding separate championships for three different Show Types.

If you're unsure what show types you should have please contact us and we'll discuss your specific situation.

Division sections will be associated with each of these show types and standings will be maintained for each of the sections separately.

Click Close and you're done.

Once you've created your Show Types the next step is to create your Divisions.
Divisions

Note: Divisions are built-in if your discipline is set to Hunter Jumper, you won't see the Divisions menu item if your discipline is Hunter Jumper. They will be pre-configured as Hunter, Jumper, Equitation, Medal, and Breeding.

Division is a term that means different things in different disciplines and needs to be clarified a bit as it relates to OrgPro. OrgPro uses the term "Division" the same way that USEF uses it, as a discipline category rather than as a specific type of class. For example in the Hunter Jumper discipline the "Divisions" are Hunter, Jumper, Equitation, Medal, and Breeding. Associated with the Hunter division are Sections such as "Green Working Hunter" and "Regular Working Hunter". What a lot of people in the Hunter Jumper world would think of as Divisions are called Sections in OrgPro.

When you select Divisions from the Data menu the following dialog box is displayed...

This is basically a list editor (see "Working With List Editors" on page 9). What you need to do is build the list of Divisions as appropriate for the Breed/Discipline that your organization is sanctioning shows for.
Something similar to this is what your Divisions might look like when you are done.

The next items you need to setup are your Sections.
Sections

Sections are what horses and members accumulate points under. You'll create a section for everything that you need a set of year end standings for. If you're using Categories a single section may yield more than one set of standings but you'll still only create one Section for those standings.

You need to create all the sections that you need under each Show Type/Division combination. Create a Section for each end of year award that you have, do not create any Sections for items that you do not have an end of year award for.

When you select Sections from the Data menu the following dialog box is displayed...

This is basically a list editor (see "Working With List Editors" on page 9).

Notice that the Show Type(s) and Divisions you created earlier are available for you to assign Sections to. You must build your list of Sections under each Division that you have.

To create a new Section click New.

In typical list editor (see "Working With List Editors" on page 9) fashion a new item is added. Edit the name to suit.

Notice that a section code has been added automatically, OrgPro has inserted the next available code in the sequence. Section codes are used to identify your sections to those that submit results to you. Letting OrgPro assign them will ensure that you have no duplicates in your codes, they must each be unique.
This is what your sections might look like for one of your Divisions when you are done. You would have to complete the process for each of your Divisions making sure to add each Section under the appropriate division.
Locations

Locations are another method of categorizing shows entirely for presentation on the Internet. You can have one Location, several Locations or many Locations depending on your circumstances. If all your shows are held in one place you can create a Location with that name or just name it <MY ACRONYM> Shows.

When you select Locations from the Data menu the following dialog will be displayed...

This is another typical list editor (see "Working With List Editors" on page 9). It also has Up/Down arrows to allow you to set the order the item appear in the list.

Click the New button to add a location and then edit the name in the edit box below.

You may add additional locations at any time.
Member Types

To set up your organizations member types select Member Types from the Data menu, and the following dialog will be displayed:

OrgPro comes with a Non Member type defined that you can neither edit or delete. If your member types will be exported to ShowPro this Non Member type is provided so that in ShowPro non members can be designated as such. It is the NM item being checked that makes this a Non Member type. You may create other non member types if you choose but do not check this box for real member types.

To add a new Member Type click the New button:

You may now edit the Member Type Name and the abbreviation. The abbreviation is printed on results reports in ShowPro.

Add additional member types as required.

When you're done you'll have something like this:

Click Close and you're done.
Categories

Some organizations offer multiple championships for the same section usually based on some geographic distinction like Local, Regional, Regular, etc. This is to allow two or more levels of competition. Obviously the horse/rider that only competes at the local shows is not going to be very competitive in the year end standings against a horse/rider that shows throughout the zone, region, or country.

To implement these multiple levels of competition all you need to do is define Categories. If you do not have multiple levels of competition then you will simply turn Categories off in your organization and not define any Categories.

Categories can also be member/horse based or show based, in the former the member or horse belong to the category, in the latter the show belongs to the category.

**Note:** Categories can be difficult to wrap your head around and there are some nuances that can add to the confusion. Your points system will be simpler if you can avoid using them but they may be required to satisfy your organizations rules. If you're considering using Categories you should probably call us to discuss it unless you're certain of what you're doing and all the ramifications.

To create Categories select Categories from the Data menu and the following dialog box is displayed...

This is basically a list editor (see "Working With List Editors" on page 9) with some special features.

To the left you'll see that "Local" and "Regular" Categories have been created which is a fairly typical configuration for Categories when they are used.

For the Local Category the "Treat as non-rated regardless of rating" box has been checked, this means that if your points are affected by the rating of the show points for this category will use the non-rated rating regardless of what the rating of the show is. This is another playing field leveling mechanism that your organization may or may not make use of.

Each Category can be associated zero or more Show Types. In some organizations categories are used for one Show Type and not another.

**Note:** If you have questions about Categories or any other aspect of your organization setup please call us.
Ratings

**Note:** Ratings are built-in if your discipline is set to Hunter Jumper, you won't see the Ratings menu item if your discipline is Hunter Jumper. They will be pre-configured as AA, A, B, C, and NR.

Ratings are only required at all if you use increment point tables by division and rating, if are not using those you do not need to set up ratings, otherwise you absolutely do need to set them up.

This is basically a list editor (see "Working With List Editors" on page 9). You just need to add the ratings to suit.

The "Not Rated" item is built-in, you won't be able to delete it or move it from the top spot, it serves as the default rating.
Points Tables

OrgPro provides complete flexibility in awarding of points. One of the most common methods of awarding points is points tables. Points tables can be single row, in which case the number of entrants in the class is not factored in. They can also be multiple row, in which case the number of entrants is used to determine the correct number of points to be awarded.

There are two types of tables, Table By Name, and Table By Division And Rating. These two table types can accommodate any table based point system.

There are some differences between tables for Hunter Jumper and other breeds/disciplines, the reason is that divisions and ratings are clear cut for Hunter Jumper and not clear cut for other breeds/disciplines. Also Hunter Jumper tables have columns to specify additional points for champion and reserve and for other breeds/disciplines these columns do not exist.

The By Name tab for a Hunter Jumper discipline with no table created...
Table By Name

Tables by Name are just that, tables that you create and assign a name to. You use Tables by Name when you don't require the extra flexibility of a Table by Division and Rating. For many organizations, one or two Tables by Name will be all they need to set up the foundation for their points system. Other organizations may use several Tables by Name and/or Tables by Division and Rating. The key point here is that any increment or straight points system can be accommodated by these tables.

Click the New button to create a new Table

If the Table by Name tab is currently selected, enter an appropriate name for your points table. It's just a label, it doesn't matter what you call it.

Table By Division And Rating - Hunter Jumper

If the By Division and Rating tab is selected, select any combination of divisions and ratings that you want the points to be determined by this particular table.

Table By Division And Rating - Non Hunter Jumper Breeds/Disciplines
For other than Hunter Jumper Breeds/Disciplines you will have created your own divisions and ratings, which might look something like what is displayed to the left.

To create your table you must name it and select at least one division and one rating. Typically several or all divisions will be set to one or more ratings.

If you find yourself assigning all divisions to all ratings then you'd be better off using a table by name because table by names simplify your points processing - there is no need to set ratings on classes.

To create a new row in your table, click the New Row button.
The **Low** range of the first row defaults to 3 but you can set it to anything you like. Usually 3 entrants are required in a class for points to be awarded.

Set the **High** range for the row. For a straight points system set the high range to 999 and create only the one row.

For Hunter Jumper you have the option to set points to be awarded to the **Champions** and **Reserve** champions of the section at the show. For other breeds/disciplines, as mentioned earlier, these columns do not exist.

The final step is to set the points to be awarded for each place.

A complete points table might look like the table below. This particular table will not award points for championships at the show.

<table>
<thead>
<tr>
<th>Low</th>
<th>High</th>
<th>Champion</th>
<th>Reserve</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>0</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Low</th>
<th>High</th>
<th>Champion</th>
<th>Reserve</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>8</td>
<td>0.00</td>
<td>0.00</td>
<td>15.0</td>
<td>15.0</td>
<td>10.0</td>
<td>5.0</td>
<td>4.0</td>
<td>3.0</td>
<td>2.0</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>15</td>
<td>0.00</td>
<td>20.0</td>
<td>15.0</td>
<td>10.0</td>
<td>5.0</td>
<td>4.0</td>
<td>3.0</td>
<td>2.0</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>25</td>
<td>0.00</td>
<td>25.0</td>
<td>20.0</td>
<td>15.0</td>
<td>10.0</td>
<td>5.0</td>
<td>4.0</td>
<td>3.0</td>
<td>2.0</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td>26</td>
<td>999</td>
<td>0.00</td>
<td>30.0</td>
<td>25.0</td>
<td>20.0</td>
<td>15.0</td>
<td>10.0</td>
<td>5.0</td>
<td>4.0</td>
<td>3.0</td>
<td>2.0</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td></td>
</tr>
</tbody>
</table>
The above Table By Division And Rating introduces another feature, a Trigger. In your points system there is a concept, Special Class Handling that allows you to award different points than normal for special classes for example "Classics" or "Derbys". These are triggered off of a term in the class name like the aforementioned "Classic" or "Derby". The need could arise to differentiate a normal Table By Division And Rating from the one to be used for the special class, you do this by entering the same trigger on the special table that you used on the special class handler. In other than this special case the trigger is blank.
Medal Qualification

Medal Qualification is used when rather than tracking a set of points standings you are tracking qualification for an end of year ride-off. To set up medal qualification parameters select Medal Qualification from the Data menu and the following dialog will be displayed...

This dialog has a list editor (see "Working With List Editors" on page 9) component to it with some additional parameters that can be associated with each item you create in the list.

Qualification can be by some number of blue or red ribbons, some number of points earned, or a combination of both.

If points are a factor in your qualification you must set the number of points that are required to qualify and specify a table by name that will be used to determine the points awarded for each place.

Don't create any more Medal Qualifications than you need if the parameters will be identical you can use the same item for multiple medals.

If you have medal classes but are determining a champion by awarding points, and not by an end of year ride off, set them up as Equitation sections, do not use Medal Qualifiers.

Most medals require some minimum number of entrants for the class to be considered a qualifying class.
This what a set of configured Medal Qualifications might look like.
Points System

Setting up your points system is a matter of assigning an increment table or other points determining mechanism to each section that you have configured for your organization.
For non Hunter Jumper breed/disciplines it will look something like this...

The Categories will only appear if your organization is using categories, in the above example categories are being used to separate points by region, one of several possible uses.

With a few mouse clicks you can set one of the following points awarding options for each of your sections:

This button displays a list of all the sections in your current list minus the currently selected section.
Any sections you select from this list will be set the same as the currently selected section. This is a very powerful tool that if used properly can make configuring your points system extremely easy. It is a good idea to set any common elements (they all may be common) in one section and then use this tool to set the rest. Then any changes that affect a limited number of sections can be made to one section and you may possibly use this tool again to propagate those changes to other sections.

<table>
<thead>
<tr>
<th><strong>No Championship</strong></th>
<th>Provided for completeness. No points will be awarded. Normally you don't include sections that aren't pointed.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Table by Division and Rating</strong></td>
<td>Points will be awarded using the table that matches the Division which will always remain the same, and the rating of the section, which may vary from one show to the next.</td>
</tr>
<tr>
<td><strong>Table by Name</strong></td>
<td>Points will be awarded using the specified Table by Name.</td>
</tr>
<tr>
<td><strong>One Point Per Dollar Won</strong></td>
<td>One point will be awarded for each dollar won.</td>
</tr>
<tr>
<td><strong>Number Placed Over Plus 1</strong></td>
<td>The points awarded will be the number of entrants placed over plus 1.</td>
</tr>
<tr>
<td><strong>Medal Qualification</strong></td>
<td>Used for Medal Sections, you must create a <em>Medal Qualifier</em> (see &quot;Medal Qualification&quot; on page 35) and associate it using the drop down box.</td>
</tr>
</tbody>
</table>

The above options set the main points determining mechanism for the selected section. There are also several options that provide additional points determining capability and flexibility.

Horse Points, Rider Points, and Horse Rider Points set who the points are awarded to, this is done on an individual section basis for maximum flexibility.

| **Use first class over fences** | If checked the number of entrants from the first class over fences will be used for all classes in the section. |
| **Model classes get half points** | If checked any class in the section with the word "Model" in its name will receive half the points than would otherwise be awarded. |
| **Limit classes get half points** | If checked any class in the section with the word "Limit" in its name will receive half the points than would otherwise be awarded. |
| **Add Number of Entrants to Table Points** | The number of entrants will be added to the table points. Another way of basing the points on the competitiveness of the class. |

[Special Class Handling: 1] Special classes such as Classics can be setup to be handled, well...specially. See below for details. The 1 on the button is indicating that there is 1 special handler set for the selected section.
### Minimum Number of Shows

Allows you to specify that the horse or rider must place in a minimum number of shows for points to count.

### Maximum Number of Shows

Allows you to specify that only points from the horse or riders best X number of shows will count.

### Carry Over Points

Allows you to have points after a specified date be applied to next years show season rather than the current show season. In next years show season, once it's created, when you select **Process Carry Over Points** on the Data menu, all the shows containing carry over points will be copied from the previous season and points will be awarded based on eligibility in the previous season. Only classes of sections with carry over configured in the previous season are copied. This is typically used for medals that do not fall within the normal start date, end date parameters of the show season.

Although you can configure points to be awarded to show champions and reserve champions in your tables, OrgPro also allows you set other scenarios for awarding points to show champions and reserve champions. These are set by checking the box and then selecting an option from the drop down box and setting the n parameter. The currently supported options are as follows:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>n x first place points/first class over fences</td>
<td>The first place points of the first class over fences in the section will be multiplied by the n parameter to determine the points.</td>
</tr>
<tr>
<td>Award n points</td>
<td>The n parameter number of points will be awarded.</td>
</tr>
<tr>
<td>Categories</td>
<td>Categories are optional and if they are not configured the Categories box will not appear. The Categories box allows you to set which sections belong to which categories. See <strong>Categories</strong> (on page 28) for more information.</td>
</tr>
</tbody>
</table>

Optionally you can specify on a per section basis a **Trophy**, **Donator**, and **Sponsor**. This information is used by OrgPro when it generates historical championships web pages for your web site.
OrgPro allows you to set up special handling for classes such as Classics or any other special class that may have special pointing requirements. When you click the Special Class Handling button the following dialog box is displayed...

![Special Class Handling](image)

The way this works is you set a "trigger" which is some text that will appear in the name of the special class. If special class handling is configured for a section and OrgPro finds a configured trigger in the name of the class the point determining will be done using the special handler settings. A section can have more than one special handler configured and rarely this may be the case.

Whichever of the 3 primary points determining mechanisms you select will override the option set for the section. You may use Table by name in both cases but specify a different table for example or you may use the same table but add a multiplier.

The **Use number of entrants from the class if applicable** check box if checked causes OrgPro to use the the number of entrants from the class itself rather than the first class over fences. If you have the Use number of entrants from first class over fences option set for you section checking this box will cause that setting to be ignored for the special class, the number of entrants in the special class will be used which most likely is what you want.

The **Add number of entrants to table points** check box can be used to either add the number of entrants to the table points or prevent them from being added.

It is highly recommended that you use the Set Others Like This button to set up your special class handlers if at all possible. It potentially can make this task very easy.
As shown below you can create "Helpers" that will further automate your points processing. You will have situations when importing results (especially non ShowPro results, i.e. USEF results) where classes are combined but the placings are not identified (coded) by the combine criteria. Helpers can handle this for you if you have the sizes, ages, or other applicable criteria defined in your data.

Below the Horse Size on Large Pony Hunter is set to L (Large), the Excluded Codes is set to 7 which is the Small/Medium Pony Hunter, and it's set to map to Small/Medium Pony Hunter on horse size. Assuming the Small/Medium Pony Hunter has sizes set to S and M if a small/medium pony places in a large pony class the code on that placing will be set to 7, the Small/Medium Pony Hunter code.

The same can be done with any of the other criteria as appropriate for the particular section.

Note that Horse Age and rider age are expressed as: <=18, <4, 2-3, >35, <=36, 12-14, you're saying that they are less than, less than or equal, greater than, greater than or equal, or with the minus sign specifying a range of ages.
High Points

OrgPro has the capability of tracking high point categories that are based on any combination of sections that you desire. In other words the high points are built on your normal year end standings. The high points can be based on horse, rider, horse rider combination or trainer.

If you have the RSMH Server your high points can optionally be uploaded there, this is controlled in File > Preferences.

Your high points have to be setup, once they are you can print reports of the standings. To set up your high points select High Points from the Data menu, the following dialog box is displayed...

To the left you have a simple list editor where you create your high point by clicking New, you then edit the name in the Name edit box.

You then specify what the high point is tracking - Horse, Rider, Horse/Rider Combination, or Trainer.

On the right you specify which sections are included in the high point. Below is what a completed high point might look like...
And here is the summary report in the Report Viewer...

<table>
<thead>
<tr>
<th>Horse</th>
<th>Exhibitor</th>
<th>Points</th>
</tr>
</thead>
<tbody>
<tr>
<td>Miss Montana Jac</td>
<td>Jennifer L. Kurtz</td>
<td>208.0</td>
</tr>
<tr>
<td>Stockings Do Impress</td>
<td>Laird P. McCabe</td>
<td>139.0</td>
</tr>
<tr>
<td>In My Wranglers</td>
<td>Cody Crow</td>
<td>132.0</td>
</tr>
<tr>
<td>Western Breezes</td>
<td>Kevin Semmel</td>
<td>96.0</td>
</tr>
<tr>
<td>Triple D Shine</td>
<td>Kathleen L. McPhaul</td>
<td>92.0</td>
</tr>
<tr>
<td>Sir Lancelot Rey</td>
<td>Teryn Muench</td>
<td>89.0</td>
</tr>
<tr>
<td>Hand Rolled Smoak</td>
<td>Corey Ode</td>
<td>82.0</td>
</tr>
<tr>
<td>DMR Little Boon Girl</td>
<td>Brent E. Callahan</td>
<td>77.0</td>
</tr>
<tr>
<td>Smokin Mirrors</td>
<td>Laird P. McCabe</td>
<td>75.0</td>
</tr>
<tr>
<td>A Legacy In Blue</td>
<td>Stephen P. Freeman</td>
<td>74.0</td>
</tr>
<tr>
<td>Blizzard Chaser</td>
<td>Danny May</td>
<td>70.0</td>
</tr>
<tr>
<td>Miss Chocolate Spark</td>
<td>Shon Wilson</td>
<td>51.0</td>
</tr>
<tr>
<td>Roygan's Smart Lena</td>
<td>Rygh Olson</td>
<td>56.0</td>
</tr>
<tr>
<td>JVS Pale Ale</td>
<td>Jennifer L. Kurtz</td>
<td>53.0</td>
</tr>
<tr>
<td>Midnight Gladiator</td>
<td>Tracie L. Bonica</td>
<td>52.0</td>
</tr>
<tr>
<td>Mr Lynx of Pines</td>
<td>Angela H. Greenshields</td>
<td>52.0</td>
</tr>
<tr>
<td>Khougar</td>
<td>Laird P. McCabe</td>
<td>51.0</td>
</tr>
<tr>
<td>MJ Cash N'Chex</td>
<td>Jolinn Hoover</td>
<td>49.0</td>
</tr>
<tr>
<td>Shiners Duality</td>
<td>Tommy Mathor</td>
<td>49.0</td>
</tr>
<tr>
<td>Jacs Electric Slide</td>
<td>Coleman Briggs</td>
<td>44.0</td>
</tr>
<tr>
<td>Smart Pyro</td>
<td>Jennifer Hancock</td>
<td>39.0</td>
</tr>
<tr>
<td>Lucky Blue Paloma</td>
<td>Jorry Jonos</td>
<td>37.0</td>
</tr>
<tr>
<td>Harda Jackie</td>
<td>Ronald Sullivan</td>
<td>36.0</td>
</tr>
<tr>
<td>JacDaniels Olena</td>
<td>Carri A. Magarizini</td>
<td>35.0</td>
</tr>
<tr>
<td>C Bornaizza</td>
<td>Lewis J. Bonaizza</td>
<td>31.0</td>
</tr>
</tbody>
</table>

American Stock Horse Association

High Points

9 Feb 2015 11:57 AM
And here is the detail report...

![High Point Details](image)

Open All Around

Miss Montana Jac / Jennifer L. Kurtz

<table>
<thead>
<tr>
<th>Show</th>
<th>Dates</th>
<th>No.</th>
<th>Class Name</th>
<th>Place</th>
<th>Points</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spring Classic Clinic &amp; Horse Show</td>
<td>April 5 &amp; 6, 2014</td>
<td>1</td>
<td>Open Pleasure</td>
<td>2nd</td>
<td>14.0</td>
</tr>
<tr>
<td>WSSH Summer Kick Off</td>
<td>May 24 &amp; 25, 2014</td>
<td>1</td>
<td>Open Pleasure</td>
<td>1st</td>
<td>2004</td>
</tr>
<tr>
<td>Prineville, OR</td>
<td>July 19 &amp; 20, 2014</td>
<td>1</td>
<td>Open Pleasure</td>
<td>1st</td>
<td>15.0</td>
</tr>
<tr>
<td>2014 Regional Championship</td>
<td>August 30 &amp; 31, 2014</td>
<td>1</td>
<td>Open Pleasure</td>
<td>1st</td>
<td>19.0</td>
</tr>
<tr>
<td>Spring Classic Clinic &amp; Horse Show</td>
<td>April 5 &amp; 6, 2014</td>
<td>2</td>
<td>Open Trail</td>
<td>1st</td>
<td>9.0</td>
</tr>
<tr>
<td>WSSH Summer Kick Off</td>
<td>May 24 &amp; 25, 2014</td>
<td>2</td>
<td>Open Trail</td>
<td>8th</td>
<td>9.0</td>
</tr>
<tr>
<td>Prineville, OR</td>
<td>July 19 &amp; 20, 2014</td>
<td>2</td>
<td>Open Trail</td>
<td>6th</td>
<td>3.0</td>
</tr>
<tr>
<td>2014 Regional Championship</td>
<td>August 30 &amp; 31, 2014</td>
<td>2</td>
<td>Open Trail</td>
<td>10th</td>
<td>8.0</td>
</tr>
<tr>
<td>Spring Classic Clinic &amp; Horse Show</td>
<td>April 5 &amp; 6, 2014</td>
<td>3</td>
<td>Open Reining</td>
<td>1st</td>
<td>17.0</td>
</tr>
<tr>
<td>WSSH Summer Kick Off</td>
<td>May 24 &amp; 25, 2014</td>
<td>3</td>
<td>Open Reining</td>
<td>1st</td>
<td>11.0</td>
</tr>
<tr>
<td>Prineville, OR</td>
<td>July 19 &amp; 20, 2014</td>
<td>3</td>
<td>Open Reining</td>
<td>1st</td>
<td>5.0</td>
</tr>
<tr>
<td>2014 Regional Championship</td>
<td>August 30 &amp; 31, 2014</td>
<td>3</td>
<td>Open Reining</td>
<td>1st</td>
<td>14.0</td>
</tr>
<tr>
<td>Spring Classic Clinic &amp; Horse Show</td>
<td>April 5 &amp; 6, 2014</td>
<td>4</td>
<td>Open Cow Horse</td>
<td>2nd</td>
<td>12.0</td>
</tr>
<tr>
<td>WSSH Summer Kick Off</td>
<td>May 24 &amp; 25, 2014</td>
<td>4</td>
<td>Open Cow Horse</td>
<td>2nd</td>
<td>10.0</td>
</tr>
<tr>
<td>Prineville, OR</td>
<td>July 19 &amp; 20, 2014</td>
<td>4</td>
<td>Open Cow Horse</td>
<td>1st</td>
<td>17.0</td>
</tr>
<tr>
<td>2014 Regional Championship</td>
<td>August 30 &amp; 31, 2014</td>
<td>4</td>
<td>Open Cow Horse</td>
<td>3rd</td>
<td>14.0</td>
</tr>
<tr>
<td>Total 208.0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Stockings Do Impress / Laird P. McCabe

<table>
<thead>
<tr>
<th>Show</th>
<th>Dates</th>
<th>No.</th>
<th>Class Name</th>
<th>Place</th>
<th>Points</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spring Classic Clinic &amp; Horse Show</td>
<td>April 5 &amp; 6, 2014</td>
<td>1</td>
<td>Open Pleasure</td>
<td>11th</td>
<td>5.0</td>
</tr>
<tr>
<td>WSSH Summer Kick Off</td>
<td>May 24 &amp; 25, 2014</td>
<td>1</td>
<td>Open Pleasure</td>
<td>7th</td>
<td>3.0</td>
</tr>
</tbody>
</table>

You can create as many high point categories as you need.
Mailing Lists

To set up mailing lists for your organization select Mailing Lists from the Data menu and the following dialog will be displayed:

You can define separate lists for different purposes. Your members can belong to as many of these lists as you like. You may have lists for a newsletter, for prize lists, or lists specific to particular show types.

Add new items to the list with the New button and then edit the name in the edit box below.

You might end up with something like this:

You designate which lists members belong to on the Members screen:

A label will be printed for this member if any of the selected lists is selected for printing.
These same mail list are used for bulk emailing using the configured email address for each member.

You can use the **Clear list of all members** button to facilitate a temporary list, a list that you need one time to make a special set of labels. After you've printed the labels you can clear the temporary list for use in the future with a different set of labels.
Trainers

You can create a list of Trainers and associate them with your members which gives you a piece of information that can at times be useful. Some prefer to set the Trainer to the name of the barn the member rides at. When you select Trainers from the Data menu the following dialog box is displayed...

Other than maintaining a list of your trainers so that they can be associated with your members this dialog box allows you, if you have the RSMH Server, to publish the list of your trainers to your web site.

On the Members Screen there is a "Trainer" check box in the flags, when you check this box if the trainer does not already exist in your list it is added and made active. If you uncheck the box the trainer is made inactive but not deleted from your trainer list. The significance of the active check box is that inactive trainers are not uploaded to the web site. To remove a trainer from the web site uncheck their Active box and re-upload. Checking their Active box and re-uploading would restore them to the web site.
If you have a trainers page on your web site you can optionally display them according to categories, typically this would be some kind of location but could be anything.

If you do not have a trainers page on your web site, or you don't need them categorized on the trainers page don't create any categories and leave them unset on your trainers.

On the Members Screen there is a drop down box where you set the trainer for the member. The first item in the list is a blank item if non of the items apply.

This is what a typical Trainers page on a web site might look like...
AHJA TRAINERS

Membership in AHJA is required to be listed here

Central Arizona

Lucy Alabaster
28618 N 53rd St
Cave Creek, AZ 85331
602-524-1617
lucyalabaster@yahoo.com

Betty Beran
9723 E. Larkspur Dr
Scottsdale, AZ 85260
602-524-7627
bizberan@aol.com

Renee Coates
25416 S. 154th St.
Gilbert, AZ 85298
602-882-5790
Phxreynigh@aol.com

Bailey Fuller
28618 N 53rd St
There is a Trainers Report that shows which members are with what Trainer.
Edit Defined Names

The USEF Results format does not break people names into first name, last name. As a result, sometimes OrgPro needs help parsing names into their component parts.

As you can see, it's not obvious even to most humans how some names should be parsed.

Sometimes you have to guess, fortunately the majority of names are more clear cut.

To save you from having to parse names more than once, OrgPro keeps track of names you have already parsed and will look them up if it can. You can select Data > Edit Defined Names from the menu if you need to make a correction to a name that you can parse.
### Edit Defined Names

#### People

<table>
<thead>
<tr>
<th>Key</th>
<th>Last Name</th>
<th>First Name</th>
<th>MI</th>
</tr>
</thead>
<tbody>
<tr>
<td>KEARABELLEOBZUT</td>
<td>Belle Obrutz</td>
<td>Keara</td>
<td></td>
</tr>
<tr>
<td>GABRIELLABROWNEDENBURN</td>
<td>Brown Edenburn</td>
<td>Edenburn</td>
<td></td>
</tr>
<tr>
<td>MARYBETHBULLOCK</td>
<td>Bullock</td>
<td>Mary Beth</td>
<td></td>
</tr>
<tr>
<td>LEEANNEBURY</td>
<td>Bury</td>
<td>Lee Anne</td>
<td></td>
</tr>
<tr>
<td>CANTERCANTERMI</td>
<td>Canter</td>
<td>Canter</td>
<td></td>
</tr>
<tr>
<td>GRACEDEGELDER</td>
<td>De Gelder</td>
<td>Grace</td>
<td></td>
</tr>
<tr>
<td>ASHLEYDELAFÉ</td>
<td>De La Fe’</td>
<td>Ashley</td>
<td></td>
</tr>
<tr>
<td>GILLIANFENTBAKER</td>
<td>Fent Baker</td>
<td>Gillian</td>
<td></td>
</tr>
<tr>
<td>RILEYANINGASAWAY</td>
<td>Gasaway</td>
<td>Riley Ann</td>
<td></td>
</tr>
<tr>
<td>KOLEENHANSENSHADEWALD</td>
<td>Hansen Shadewald</td>
<td>Koleen</td>
<td></td>
</tr>
</tbody>
</table>

#### Entities

<table>
<thead>
<tr>
<th>Key</th>
<th>Entity Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>BAYSIDEQUESTRIANCENTER</td>
<td>Bay Side Equestrian Center</td>
</tr>
<tr>
<td>HHFEQUINESALESLLC</td>
<td>Hhf Equine Sales LLC</td>
</tr>
<tr>
<td>STGEORGEQUESTRIANCENTER</td>
<td>St George Equestrian Center</td>
</tr>
<tr>
<td>WINDERMEREQUESTCENTER</td>
<td>Windermere Equest Center</td>
</tr>
</tbody>
</table>

- [Delete Selected Person](#)
- [Help](#)
- [Close](#)
CHAPTER 3

The Members Screen

The Members Screen is where you will work with your organizations members.
This is what you will see the first time you run OrgPro. The screen is disabled because there are no members in the database.

This is what the Members Screen will look like after an organization is up and running with OrgPro™.

Notice the **Horses** drop down box. If a member has acquired points on more than one horse, you can select the horse and click the Horses button, and OrgPro™ will take you to the **Horses** Screen for the selected horse.

The Notes box has been collapsed by clicking on it, it can be expanded by clicking on it again.

The zero points highlighted in the magenta color are from a show that was not in this members top 15 shows.
In This Chapter

Members Screen Features .................................................. 58
The Members Menu .......................................................... 62
Members Screen Features

At the top of the members screen all the basic member information is maintained.

To change information on this screen, just type it in. There is no need to press enter.

If member numbers are being assigned automatically, the member number is assigned each time a member is added to the database. Member numbers begin at 3551 and each new member is assigned the next available number in the series. We recommend that these numbers be assigned for life and that you do not remove people from the database and reassign number to other people, although you may elect at some point to remove people from mailing lists. The determining factor in whether a person is a member of the organization is not that they are in the database but that their dues current. OrgPro knows whether or not they are valid member so you don't have to worry about it.

There are a set of Flags that you can check for Card Printed, Life Member, Family Member, and whether they are an entity (business or farm). When entity is check the last, first, and middle initial fields will merge into one long name field.

There is a drop down box that contains the Member Types you set up. This where you will set each persons member type.

You will select which mailing lists the person is subscribed to using the Mailing Lists check list box. Just check the ones you want them to be a member of.
The members points are in the center section of the members screen.

The Section drop down box will contain any sections that the member has accrued points in. When you select a different section, the points for that section will be displayed.

Across the top is displayed:

- The current section (in the prop down box)
- Current selected section / number of sections
- The members standing in the section
- The Show Type
- The Location

Contained in the table is:

- The class number
- The name of the class
- The name of the horse show
- The horses name
- The place
- The number of entries in the class
- The points awarded

At the bottom of the table the total points is displayed.

If your organization awards extra points to champions and reserves (Hunter Jumper only) at the show those are tracked in the table underneath the placings table as show above. In this case you have sub totals for Total Class Points and Total Championship Points which are totaled into a Total Season Points.

There are a set of buttons underneath the Class Points Table, these buttons which are described below are used to operate on either the Class Points Table or the Championships Points Table if your organization awards extra points for champion and reserve.
When you click the **Go To Points** button you will be taken to the Points Screen and the Show, Class, and selected place or championship will be selected.

The **Reallocate** Points button is used to move points from one member to another, probably because they were applied incorrectly to begin with.

By entering in another members number you can move the points for the selected row in the table to that member.

Checking the Reallocate All box will cause all the points for the selected section to be transferred.

The **Revoke** Button is used to revoke the points for the currently selected place or standing.

The **Revoke All** Button is used to revoke all the points for the currently selected section.

The **Unrevoke All** button is used to reverse a revoke all. The points will be restored to their original values.

The **Override Button** is used to control precisely the number of points that are awarded when for whatever reason the standard points that are awarded are inappropriate.

When you click the button the dialog box to the left is displayed. You enter in the number of points desired and you can also enter in a reason for your future reference.

If an override already exists on a place or a championship it's points and reason will be displayed and you can cancel it using the Cancel Override button, the points will be restored to standard values.

At the bottom of the screen there is the members button panel.

To add a new member click the **New** button in the lower left corner of the screen.
To remove a member click the **Delete** button.

Use these buttons to step to the prior or next member in the database.

The Refresh button saves everything on the screen out to disk and then reads it back in. Data is stored automatically in OrgPro, there's no reason normally to use this button but it is provided for situations where you want to store the data without leaving the screen you are on.
The Members Menu

These are the items on the Members Menu, and what they do.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Members</td>
<td>Use this item to print a list of your membership database. You will have a number of filtering options - paid member, unpaid members, life members, all members.</td>
</tr>
<tr>
<td>Export Members</td>
<td>Use this item to export your membership database to a tab delimited text file that can be opened in Excel or a text editor. You will have a number of filtering options - paid member, unpaid members, life members, all members.</td>
</tr>
<tr>
<td>Print Member Counts</td>
<td>This item will print a report that details members by member type and paid status.</td>
</tr>
<tr>
<td>Refresh Points</td>
<td>This causes the members points to be updated in the event that something should change that would effect their points, such as a change in the Date Dues Paid.</td>
</tr>
<tr>
<td>Refresh Web Data</td>
<td>This is a RSMH function, it will not be visible on the menu unless an RSMH account is configured. This function first performs a Refresh Points and then connects to the web server and reconciles the show record of the currently selected member for the currently selected season on the web with what is in OrgPro. The show record for this member on the web will agree perfectly with what you have in OrgPro after performing this function.</td>
</tr>
<tr>
<td>Print Member Points</td>
<td>This prints a complete points report for all sections the currently selected member has placed in.</td>
</tr>
<tr>
<td>Print Membership Card</td>
<td>This prints a single membership card for the member on the screen.</td>
</tr>
<tr>
<td>Process Membership Cards</td>
<td>Use this item to print membership cards in batch mode. A card will be printed for every member whose dues have been paid that has not yet been issued a card. You will also have an opportunity to print a mailing label for each card printed to facilitate mailing.</td>
</tr>
<tr>
<td>E-Mail Membership / Recording Cards</td>
<td>Use this item to send the member an membership E-Card and recording E-Cards for any eligible horses owned by the member.</td>
</tr>
<tr>
<td></td>
<td>Note: E-Cards require the RSMH server option.</td>
</tr>
<tr>
<td>Process E-Cards</td>
<td>Use this option to process E-Cards for a selected range of fee paid dates and send an E-Card and recording E-Cards for any eligible horses owned by the members whose fee paid date falls in the selected range and that do not have their card issued box checked.</td>
</tr>
<tr>
<td>Print Membership Directory</td>
<td>Prints an alphabetical membership directory with names, addresses, phone number, member number, and member type.</td>
</tr>
<tr>
<td>Table Heading</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Print Membership Booklet</strong></td>
<td>Prints a membership list in a format suitable for incorporating into a booklet.</td>
</tr>
<tr>
<td><strong>Print Mailing Label</strong></td>
<td>This prints a single mailing label for the member on the screen.</td>
</tr>
<tr>
<td><strong>Process Mailing Labels</strong></td>
<td>Use this item to print mailing labels. You will select which lists to include and OrgPro™ will print a label for everyone that is on any of the selected lists.</td>
</tr>
<tr>
<td><strong>Set Member Inactive</strong></td>
<td>Used to set the member to inactive status.</td>
</tr>
<tr>
<td><strong>Inactive Members</strong></td>
<td>Used to search for inactive members and make them active again.</td>
</tr>
<tr>
<td><strong>Mailing List Stats</strong></td>
<td>This item will display a count of the number of members subscribed to each mailing list.</td>
</tr>
<tr>
<td><strong>Members All Placings Record</strong></td>
<td>This will create a report showing all of the members placings spanning all show seasons. This can be helpful for determining eligibility.</td>
</tr>
<tr>
<td><strong>Members Show Record Web Page</strong></td>
<td>Visible if the RSMH Server is active, opens the members show record web page in the default system web browser.</td>
</tr>
</tbody>
</table>
The Horses Screen

The Horses Screen is where you will work with your organizations horses.

Notice the **Riders** drop down box. If a horse has acquired points with more than one rider, you can select the rider and click the Riders button, and OrgPro will take you to the **Members** Screen for the selected rider.
In This Chapter

Horses Screen Features .......................................................67
The Horses Menu ...............................................................71
Horses Screen Features

At the top of the horses screen all the basic horse information is maintained.

To change information on this screen, just type it in. There is no need to press enter.

If recording numbers are being assigned automatically, the recording number is assigned each time a horse is added to the database. Recording numbers begin at 1251 and each new horse is assigned the next available number in the series. We recommend that these numbers be assigned for life and that you do not remove horses from the database and reassign numbers to other horses. The determining factor in whether a horse is a recorded is not that they are in the database but that their dues are current. OrgPro knows whether or not they are recorded so you don't have to worry about it.

The Owner # field contains the owner's membership number. If you type in the owners number and press Enter, the owners name will update immediately. Pressing Enter is not required but give you the immediate feedback that you have the intended owner.

Note: Most organizations require that the person registering the horse also be a current member of the organization but you can specify that the owner and/or the rider, or neither, must be a member to get points.
The horses points are in the center section of the horses screen.

The Section drop down box will contain any sections that the horse has accrued points in. When you select a different section, the points for that section will be displayed.

Across the top is displayed:

- The current section (in the prop down box)
- Current selected section / number of sections
- The horses standing in the section
- The Show Type
- The Location

Contained in the table is:

- The class number
- The name of the class
- The name of the horse show
- The riders name
- The place
- The number of entries in the class
- The points awarded

If points are being awarded for show championships, a second table will appear with the details and totals for those points and the total points will be displayed to the left. Otherwise the total points are displayed at the bottom of the class points table.
Notice the pop up menu in the picture above. Right clicking on the table will cause this menu to appear. With the Reallocate Points option you can move points that have been awarded in error to another horse:

There are a set of buttons underneath the Class Points Table, these buttons which are described below are used to operate on either the Class Points Table or the Championships Points Table if your organization awards extra oopoints for champion and reserve.

When you click the Go To Points button you will be taken to the Points Screen and the Show, Class, and selected place or championship will be selected.

The Reallocate Points button is used to move points from one member to another, probably because applied incorrectly to begin with.

By entering in another horses number you can move the points for the selected row in the table to that horse.

Checking the Reallocate All box will cause all the points for the selected section to be transferred.

The Revoke Button is used to revoke the points for the currently selected place or standing.

The Revoke All Button is used to revoke all the points for the currently selected section.

The Unrevoke All button is used to reverse a revoke all. The points will be restored to their original values.

The Override Button is used to control precisely the number of points that are awarded when for whatever reason the standard points that are awarded are inappropriate.

When you click the button the dialog box to the left is displayed. You enter in the number of points desired and you can also enter in a reason for your future reference.

If an override already exists on a place or a championship it's points and reason will be displayed and you can cancel it using the Cancel Override button, the points will be restored to standard values.
At the bottom of the screen is the horses button panel.

![Button Panel Image]

To add a new horse click the **New** button in the lower left corner of the screen.

To remove a horse click the **Delete** button.

![New & Delete Buttons]

Use these buttons to step to the prior or next horse in the database.

![Prior Horse & Next Horse Buttons]

The Refresh button saves everything on the screen out to disk and then reads it back in. Data is stored automatically in OrgPro, there's no reason normally to use this button but it is provided for situations where you want to store the data without leaving the screen you are on.

![Refresh Button]
# The Horses Menu

These are the items on the Horses Menu, and what they do.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Print Horses</strong></td>
<td>Use this item to print a list of the horses in your database. You will have a number of filtering options - paid horses, unpaid horses, all horses.</td>
</tr>
<tr>
<td><strong>Export Horses</strong></td>
<td>Use this item to export a list of the horses in your database to a tab delimited text file that can be opened in Excel or a text editor. You will have a number of filtering options - paid horses, unpaid horses, all horses.</td>
</tr>
<tr>
<td><strong>Count Horses</strong></td>
<td>This item will display a count of the total number of horses in the database and the total paid horses.</td>
</tr>
<tr>
<td><strong>Refresh Points</strong></td>
<td>This causes the horses points to be updated in the event that something should change that would effect their points, such as a change in the Date Fee Paid.</td>
</tr>
<tr>
<td><strong>Refresh Web Points</strong></td>
<td>This is a RSMH function, it will not be visible on the menu unless an RSMH account is configured. This function first performs a Refresh Points and then connects to the web server and reconciles the show record of the currently selected horse for the currently selected season on the web with what is in OrgPro. The show record for this horse on the web will agree perfectly with what you have in OrgPro after performing this function.</td>
</tr>
<tr>
<td><strong>Print Horses Points</strong></td>
<td>This prints a complete points report for all sections the currently selected horse has placed in.</td>
</tr>
<tr>
<td><strong>Print Recording Card</strong></td>
<td>This prints a single recording card for the horse on the screen.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>This menu item does not apply and will not be visible if your horse eligibility to receive points is determined by the date of the owner’s membership.</td>
</tr>
<tr>
<td><strong>Process Recording Cards</strong></td>
<td>Use this item to print recording cards in batch mode. A card will be printed for every horse whose fee has been paid that has not yet been issued a card.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>This menu item does not apply and will not be visible if your horse eligibility to receive points is determined by the date of the owner’s membership.</td>
</tr>
<tr>
<td><strong>Set Horse Inactive</strong></td>
<td>Used to set the horse to inactive status.</td>
</tr>
<tr>
<td><strong>Inactive Horses</strong></td>
<td>Used to search for inactive horses and make them active again.</td>
</tr>
<tr>
<td><strong>Horses All Placings Record</strong></td>
<td>This will create a report showing all of the horses placings spanning all show seasons. This can be helpful for determining eligibility.</td>
</tr>
<tr>
<td><strong>Horses Show Record Web Page</strong></td>
<td>Visible if the RSMH Server is active, opens the horses show record web page in the default system web browser.</td>
</tr>
</tbody>
</table>
To search for members or horses in OrgPro click the **Search** button in the lower right corner of the **Members** and **Horses** screens. The following search tool will be displayed...

Members or horses, active or inactive, can be searched for with this tool. OrgPro will switch to the appropriate screen to display the searched for member or horse if required. Depending on what screen you're on when you open the tool, or how you opened the tool, the cursor will appear either in the horse or member search box. If you just click the Search button or press Alt/s on the keyboard the cursor will be in the horse search box if you're on the **Horses** screen or will be in the members search box if you're on the **Members** screen. If you press Alt/p on the keyboard the
members (people) search box will be activated regardless of which screen you are currently on. If you press Alt/h on the keyboard the horses search box will be activated regardless of which screen you are on.

You can use the up/down arrow keys to switch between the member/recording number box and the name search box. So if you want to search by number activate the tool appropriate for what your searching for, press the up arrow, enter in the number, and press Enter.

To use the search box start typing in the name, the name will be populated with the closest matching names, as you continue to type the list will narrow. At any points if you see the item you are searching for you can arrow down into the list and select it by pressing enter You can also double click on an item in the list window to go to that member or horse.
Although horse show results can be imported from ShowPro or USEF electronic results, which dramatically reduces the effort required to manage points for your organization, there is a need to create a show manually in some cases.

To create a show in OrgPro select Create Show from the File menu.

OrgPro supports sub shows (two or more identical or similar shows combined into a single show, commonly referred to as split combined shows), and, for breed/disciplines other than Hunter Jumper, multiple judges. You will first be asked if the show is a split combined show (do you need sub shows)...

**Note:** Sub shows are very common in Quarter Horse and other stock breed shows, if your organization is Hunter Jumper you probably won't have sub shows.

If you answer Yes the next thing you'll see is this...
You will create an item for each of your sub shows setting a name and a color.

Similar to as shown to the left.

And you'll have a set of buttons to interact with your sub shows....
If you didn't configure sub shows you won't have the sub show buttons...

In This Chapter

Using the Create Show Page ..............................................79
Using the Create Show Page

Creating a show is simply a matter of setting the location, name, the dates, and adding the classes using the list of sections that you configured when you set up your organization.

If you specified that you were using sub shows you'll have sub show selector buttons to the lower right of your classes table. These allow you to select sub shows individually or to select all sub shows and additionally whether to stack or interleave the classes for the sub shows. If you have All selected every action you perform will be performed on all sub shows, if your sub shows are identical, which they frequently are, this is a very powerful labor saving option. If your sub shows are not identical you should stick to using the S1, S2... buttons.
The **Locations** drop down contains the locations that you have configured for your organization. Select the location of the horse show from the list.

Type the name for your horse show into the **Name** edit box.

Set the start and end dates for your show using the drop down calendars provided.

At this point the only task remaining is adding the classes to your show. Each class belong to a section and adding a class is a simple matter of selecting the section and then clicking the **Add** button (the hand pointing to the right) to add the class to the show.

If you have more than one show type you will have a list of sections for each than can be selected with the **Show Types** drop down. If you only have one show type it is implicitly selected and the drop down box will not appear.

Your list of sections is sub-divided by division to make it easier to locate each section in the list. Select the division from the **Divisions** drop down.
Now click on the section that the class you want to add belongs to and click the **Class Add** button to add the class to your show.

If you're using sub shows make sure you have the appropriate sub show(s) selected before you push the class over - with the All button selected you can build all sub shows at the same time assuming they are identical.

If you have **Insert** selected the class will be inserted before the currently selected row. If you also have **Smart Numbering** checked the classes will be renumbered to the next break in the numbering. Smart numbering will also happen when deleting or moving classes up or down, it's important to pay attention to this setting to get the desired outcome.

Click on the **Class Up** button to move a class up in the order.

Click on the **Class Add** button to add a class to the show.

Click on the **Class Remove** button to remove a class from the shows.

Click on the **Class Down** button to move a class down in the order.

Your completed show will look something like this...
### OrgPro - Hunter Jumper Association of Michigan - HJAM 2014

#### Location

**HJAM/JJ Horse Shows**

#### Name

**Waterloo I**

#### Show Types

- **Regular Member Show**

#### Divisions

- **Hunter**

#### Sections

- **First Year Green Working Hunter**
- **First Year Green Working Hunter U/S**
- **Second Year Green Working Hunter**
- **Second Year Green Working Hunter U/S**
- **Third Year Green Working Hunter**
- **Third Year Green Working Hunter U/S**
- **Amateur Owner 18-35**
- **Amateur Owner 18-35 U/S**
- **Adult Amateur Hunter 36-49**
- **Adult Amateur Hunter 36-49 U/S**
- **Adult Amateur Hunter 50+**
- **Adult Amateur Hunter 50+ U/S**

#### Start Date

7/2/2015

#### End Date

7/5/2015

#### Class Name

- **First Year Green Working Hunter**
- **First Year Green Working Hunter U/S**
- **Second Year Green Working Hunter**
- **Second Year Green Working Hunter U/S**
- **Third Year Green Working Hunter**
- **Third Year Green Working Hunter U/S**
- **Amateur Owner 18-35**
- **Amateur Owner 18-35 U/S**
- **Adult Amateur Hunter 36-49**
- **Adult Amateur Hunter 36-49 U/S**
- **Adult Amateur Hunter 50+**
- **Adult Amateur Hunter 50+ U/S**

#### Append

- On

#### Insert

- On

#### Smart Numbering Enabled

- On
The points screen is where you will make adjustments to the place data that is imported from ShowPro, USEF Electronic Results, or enter the results for a show that you have created within OrgPro.

This is what your Points Screen looks like after a successful horse show season with OrgPro. The above points screen happens to be for a Hunter Jumper organization, there is the possibility with breeds and disciplines other than Hunter Jumper to have multiple judges and sub shows.
In This Chapter

Using The Points Screen ..........................................................85
Using Update Show Points/Refresh Points .........................94
Class Judges ...........................................................................97
Using The Points Screen

The points for a class can go to the horse, the rider, or to the horse/rider combination. Above the green highlighting indicates that the points are going to the horse/rider combination for the selected class. If the horse or the rider were getting the points then only the one item would have the green highlighting.
Down the left side are all the shows that have been imported from ShowPro, USEF Electronic Results, or created within OrgPro. Each time you import or create a show, another item is added to the list.

In the center is the list of classes from the show that is selected on the left.

On the right are the results of the selected class in the center.

In the lower right section of the screen is all the information that pertains to the place that is selected in the places table on the right side of the screen and any champion/reserve information if the breed/discipline is Hunter Jumper.

The numbers in the place table are recording numbers, membership numbers, or a combination of the two, depending on the type of class selected. If it's a class judged on the horse they are horse recording numbers. If it's a class judged on the rider, they are membership numbers. If it a class class judged on the horse/rider combination they will be a recording number/membership number combinations.

Notice that some of the places in the places table to the right have a numbers that are zero. The reason, is that either the horse and/or member was not in the ShowPro database at the show as a recorded horse of the organization, or the horse and/or member is just not in the organizations database. If the member or horse is in the organizations database, you can enter the numbers directly into the table or into the Horse No. or Rider No. fields as appropriate and press Enter. The number(s) will appear in the place, and if the place is eligible the points will be awarded.

In the example above there are two sub shows with two judges for each sub show, so changing the judge will display the placings for the selected judge, and you must be sure to have your judge properly selected before you begin entering or editing results.

The following fields are used to enter results for shows. If you are importing results from ShowPro, these fields will automatically be updated. In this case you may still use these fields to make corrections. If you have created a show within OrgPro, you will be using these fields to manually set the results for your show.

You can also enter recording and/or membership numbers directly into the table, recording numbers if the points are going to the horse, membership number if the points are going to the rider, and combination horse/rider numbers if the class is horse/rider combination. If the points are going to the horseTo set the rider where the points are going to the horse or the horse where the points are going to the rider you must use the fields described below.

These fields are used to identify the rider and horse for each place:

If you have the riders membership number, enter it into the Rider No. field and press Enter. This will record this person as the rider for the currently selected place. You can change the rider on a place by changing the existing number and pressing Enter.
If you don't have the membership number start typing the rider's name into the Rider Name field...

...and a list of the closest matches from the database will pop up. You can use the arrow/enter keys at any time to select a person, as you type the list will continue to narrow. Pressing the Esc key will close the box with no selection made.

If you have the horse's recording number, enter it into the Horse No. field and press Enter. This will record this horse for the currently selected place. You can change the horse on a place by changing the existing number and pressing Enter.

If you don't have the horse's recording number start typing the horse's name into the Horse Name field...

...and a list of the closest matches from the database will pop up. You can use the arrow/enter keys at any time to select a horse, as you type the list will continue to narrow. Pressing the Esc key will close the box with no selection made.

**Note:** When you record a place the places table field will automatically advance to the next field. This makes it faster and easier to enter results.

The Refresh Show Points button quickly recalculates and refreshes all the points for the selected show. Also see *Update Show Points* (see "Using Update Show Points/Refresh Points" on page 94).
The Refresh Show Points button quickly recalculates and refreshes all the points for the selected show. Also see Update Show Points (see "Using Update Show Points/Refresh Points" on page 94).

If you have sections that require it you may have the Post Process Points button. This comes into play when you have a min or max number of shows set on one or more sections.

When you have these kinds of points mechanisms in place any change that occurs in a set of points has the potential to alter points anywhere in the set. If you're tracking a horses best 10 shows for example every new show that the horse participates in has the potential to change the ten best shows. So when this potential arises OrgPro highlights in red the placings that need to be post processed to alert you that you need to perform this function. A green color indicates points were not awarded because the min show requirement was not met. A magenta color indicates points were not awarded because the show wasn't in the top best shows.

These fields are used to set other important points determining information:

If you are using increment tables, the number of exhibitors is crucial in determining points. Shows imported from ShowPro will already have this set providing the show secretary verified the entries. If you've created your own show within OrgPro, you set the number of entries manually here.

If you are awarding one point per dollar won as is often done for Jumper sections, enter the prize money into the Money field. Shows imported from ShowPro will already have this set.

The Place Section Drop Down can be used to set the sections on an individual place basis. This could become necessary when sections are combined.
The Set Classes button allows you to set the section for one or multiple classes. You just select the class(es) you want to set and then click the Set button. You then use the provided interface (not pictured) to select the section. All places for all selected classes will be set to the selected section.

If you are using increment tables by division and rating the rating of the sections becomes crucial for properly assigning points. To set your ratings for your sections, click the Set button.
You can set the rating for each individual section to AA, A, B, C, or NR.

For Hunter Jumpers if your points system is configured to award extra points for champion and reserve the following table will be available to display and/or enter the required information. You can use the New button to create a new championship item, set the standing with the drop down. Type in the horse and rider number and press Enter after each to pull the name from the database.

The best and easiest way to add a champion or reserve is to right click in the place cell and select Champion or reserve from the menu that pops up.

The menu will only appear if a championship is possible for the section and the selected place has already been awarded points for placing.

If you are awarding championship points based on the number of entrants in the first class, that class is identified by checking this box. Shows imported from ShowPro will have this box checked for you.
The multiplier gives you the ability to weight points by a factor. The factor is normally 1.0 but it can be set from 0.01 to 999.99. Clicking the Set button allows you to set the multiplier for whatever classes you select from the displayed list.

Class Groups come into play when you have two or more sections mapped to a single section but you need to establish the first class over fences for points determination purposes. When you click the Class Groups button the following dialog box is displayed...

Here we have 1st and 2nd Year Green Hunter. These were imported from ShowPro as Green Working Hunter because this organization recognizes only Green Working Hunter and doesn't offer separate year end championships for 1st and 2nd Year Green Hunter. Setting the Group for the first year classes to zero and the Group for the second year classes to 1 gives OrgPro enough information to determine the first class over fences.

If your points system has Use number of entrants from first class over fences checked this will be important if you import mapped sections from ShowPro.

The Go To Horse button takes you to the Horses Screens and positions you on the horse from the currently selected place. The green highlighting is an indication the points for the currently selected place go to the horse.

The Go To Rider button takes you to the Members Screens and positions you on the rider from the currently selected place.

You can edit an existing show by clicking the Edit Show button. See Creating a Show (on page 75) for more information.

You can export a show by clicking the Export button. This exports a show in the same format as ShowPro, which means that this exported show can be imported into OrgPro. If you have one person managing points for an organization, and another managing the membership, each with their own copy of OrgPro, the points manager can export shows for import by the membership manager. There are also ways available for the points manager to import membership data from the membership manager.

You can View the results for a show in the Report Viewer which is the best place to find potential problems with your points.
With the **Search** button you can search the currently selected show or all shows for a horse or a rider, all placings will be listed in a pop up window and you can click on each to go to that place.

The **Upload** button is used to upload an individual show to a RSMH (Results, Standings, Members, Horses) database if you have an RSMH capable account with Sport Data.

If a horse or rider has zero points the **Why** button will tell you why.

Depending on what is currently selected the Delete button will read Delete Show, Delete Class, or Delete Place. If one of these items is not selected the button will not be visible. This button allows you to delete anything from a single place up to an entire show.

The same delete button mentioned above, if the classes list is the selected list, and the shift key on the keyboard is pressed, becomes a Delete Classes button, and if clicked the following class selection dialog box is displayed...

This gives you the ability to select multiple classes and delete them as sometimes you might want to do if a show you imported has classes that are not recognized by your organization.

Checking this box will prevent the selected show from being posted to the web site.
This check box will only be visible if you're using the Max Shows option, it allows you to not consider the selected show as one of the max shows.

**Cloning Shows**

Some organizations sanction lots of shows (even hundreds) that have to be manually entered and are identical to each other. In this case it is very helpful to be able to clone a show that has already been created and make a new show that already has all the classes in it.

On the Points screen if you select a show that you want to clone, hold down the shift key on the keyboard while clicking the **Edit** button, the dialog to the left will be displayed.

If you click yes the currently selected show will be cloned into a new show and you will be taken to the Show Screen where you can set the name, dates, and location appropriately.
Using Update Show Points/Refresh Points

At the bottom of the Points Screen is the **Identify Horse/Riders** Button.

In the Point Screen Basics section we described the situation where we had zero in the places instead of organization numbers. We discussed how to plug in numbers and press **Enter** to update points on an individual place basis.

The **Update Show Points** button does this same thing but does it automatically, with a little help from you, for an entire show.

When you click **Update Show Points** OrgPro, if it finds any zeros in the places, will present you with opportunities to correct the situation.

This is asking you if you can identify the horse Grand Tour. The horses to the right are horses from the database. The owners of the horses are added to the horses name as an aid in identifying them. Bear in mind that there may be a typographical error in the horses name or a misspelling that caused it to not be recognized at the show.

If you can match the horse on the left to one of those in the box on the right, click on the horse in the box to highlight it and then click **Yes**. In this case there is a match, so you would click **Yes**. The top bar graph is indicating how far you are through the overall process of updating the show points. The bottom bar graph is indication how good of a match the currently selected horse is, in this case the match is better than it appears because of the first initial not matching the full name.
You will also have situations with riders that you will handle exactly as described above. It's somewhat debatable whether there is a match in this case.

Either or both the horse and rider dialogs may pop up multiple times, each time with a new situation that OrgPro is requesting your help with. When the Update Show Points process is complete the following dialog box will be displayed.

When you complete the Identify Horses/Riders a Refresh Show Points is performed, it is this action that actually displays the above messages.
The **Refresh Show Points** button refreshes the points for every place, and in the case of Hunter Jumper, championship in the show.

If you hold the shift key while pressing this button the points will be refreshed for all the shows.

After you do a **Refresh Show Points** the Helpers / Actions report will appear if there are things that need attention or if any actions have been performed on your behalf according to any Helpers you have configured.
Class Judges

Classes other than Hunter Jumper classes can have up to eight judges assigned to them. OrgPro has a tool that allows you to assign judges to your classes and also to view those assignments once they have been made. When you click on the **Class Judges** button on the Points Screen the following dialog is displayed...
Again this tool is used to set or to view your judge assignments, to view your judge assignments select **Viewing class Judge assignments**, to set your judge assignments select **Assigning Judges to classes**.

If you are using sub shows you will have a distinct list of judges for each sub show. Names will probably be duplicated in the different sub shows but the competition numbers will probably be unique.

In most shows that have multiple judges each one has their own competition number, if that is the case for your show you should set the competition number, it will be a helpful reference.

### Setting Judges

To set your judges...

1. Select Assigning Judges to classes
2. If you're using sub shows make sure you have the correct one selected.
3. Build a set of one or more judges in the center box by pushing them over from the left most box.
4. Select the classes in the right most box that should be assigned the set of judges you have built in the center box by dragging the mouse, Ctrl/clicking, or clicking Select All.
5. Click the right pointing hand to the right of the Class Judges box to assign the set of judges to the selected classes.

### Viewing Judges

1. Select Viewing class Judge assignments
2. Click on any class in the right most box to see the assigned judges in the center box.

When you have multiple judges configured a judge selector drop down box will appear underneath the placings table on the Points Screen, this enables you to enter a unique set of results for each judge.
There are items on the Reports menu that will enable you to view and print a variety of reports. All reports are initially displayed in the Report viewer and you can print them from there.
There are also member specific reports on the Members menu and horse specific reports on the Horses menu. Users are encouraged to let us know if there is a particular report that would be helpful to their organization that is not available.

RSMH Server
The RSMH Server uses a database resident on the web server along with special programming, also on the web server, to dynamically produce RSMH (Results, Standings, Members, and Horses) content. Entire show records can be accessed for members and horses spanning multiple showing seasons.

The RSMH Server requires special programming on the server and for that reason can only be hosted on the Sport Data web server. You must have a web site hosted with Sport Data or you can obtain from us a RSMH account that will host only your RSMH content with the rest of your web site hosted on another server.

### Configuring Web Upload

To configure OrgPro for RSMH select **Web/Upload/Configure** from the menu and enter the following information obtained from Sport Data.

- Web Site (without any www.)
- User name
- Password

You will obtain the User Name and Password from Sport Data. Once these parameters are entered you should be able to successfully connect to the web server.
Uploading RSMH Data

There are several different ways to upload RSMH data to the web server, each with its own purpose...

Upload Season
You should select Web/Upload/Upload Season at the beginning of a new season or to upload a past season that is not yet resident on the server. This function uploads everything, all organization data, all shows, all members and horses.

Upload Members/Horses
Selecting Web/Upload/Members/Horses from the menu causes the members and horse to be uploaded. If you have separate Membership and Points Secretaries your Membership Secretary will use this function to update the members and horses on the web site.

Upload Show
Clicking the Upload button on the Points Screen will upload the currently selected show to the web site. This is the results and updated standing are posted to the web site when a new show has been added.

Upload Sections
Selecting Upload Sections from the menu causes the list of configured sections to be uploaded to the web server. This can be used if a section is added mid season or if you adjust the order of your sections in the list and you want them to appear on the web in that order.

Refresh Web Data
This is a menu item available on both the Members and the Horses menus if you have an RSMH account or enabled web site. It pertains to the currently selected member or horse. You must have a connection to the internet to use it. What it does is reconcile the points for the currently selected season on the web with what you currently have in OrgPro for the currently selected member or horse. If you make a points change that affects a limited number of members or horses, i.e adding/removing points or moving points from one member/horse to another, this function can be used to upload those changes without having to upload the entire show. After using this function the show record for the currently selected season on the web should agree perfectly with what you have in OrgPro.
Selecting any of the above functions with the exception of Refresh Web Points will cause an upload dialog box similar to this one to be displayed. With Refresh Web Points the cursor will change to an hour glass while the function is being performed.

Clicking the Upload button will start the upload.

Messages will be displayed indicating progress and eventual success. If your upload does not succeed please contact Sport Data.
Upload Management

Upload Management allows you to control who has access to the organization data that you provide and also allows you to monitor who has downloaded which updates. The job of the Points Secretary becomes more difficult if the data that OrgPro provides is not utilized by the Show Secretaries. It is very helpful to know who is properly utilizing the provided data and who if anyone is not. When you select Upload Management from the Web/Server menu the following dialog box is displayed...

The log lists the updates that have been posted, who has downloaded them, and when.

You will control who has access to the organizations data on the web server by issuing usernames and passwords. To add a user or to change an existing users password click the Add/Update User button, the following dialog box will be displayed...
The list of existing users appears in the list at the bottom. You can click on a name in the list to select it, you can then enter a new password and/or email address and click Add/Update to post the data.

To add a new user just type the user name in the empty User Name box, a password into the Password box, an email into the Email Address box, and then click the Add/Update button. It is highly recommended that you use the first initial and last name as your user names as it makes the identity of the person clear.

If you enter email addresses for your users they will receive an email notifying them that an update has been uploaded.

To remove a user click the Remove User button and the following dialog box is displayed...

Simply click on the user to be removed to select it and then click the Remove button. The person will no longer be able to access the organizations data.
Uploading Org data

Upload Org Data is used to make organization data available to ShowPro users, by importing this data into ShowPro they gain the ability to export high quality show results to you electronically.

If you have a points secretary using also OrgPro they can obtain the membership data, which they need to process points, by using the Download Org Data function.

To export organization data, click **Upload Org Data** on the **Web** menu and the following dialog will be displayed...

To start the upload click the Upload button. Progress information will be displayed in the window.
Chapter 8  RSMH Server  107

Downloading Org Data

If your organization has separate membership and points secretaries the points secretary is going to need to obtain the membership data from the membership secretary. The Download Org Data function is provided for that purpose. The points secretary will download the updates that the membership secretary provides in the same manner that the show secretaries download data into ShowPro. To download data or to check if an update is available for download select Download Org Data from Web/Server menu.

![Download Org Updates dialog box]

You have a few options for importing, if you are a points secretary you may only want the membership data - you may not want your points configuration overwritten by the membership secretaries points configuration.

![Select Import Option dialog box]

---

*This is a sample text from a technical document.*
OrgPro has the capability to do bulk Emailing to your membership.

When messages are sent OrgPro automatically attaches an appropriate greeting to the beginning of the message and the signature to the end. You will need to edit the signature information one time, you do not necessarily need to include all the information as in the sample.

In This Chapter

Email Tool ................................................................. 110
Sending Bulk Emails ............................................. 111
Email Tool

OrgPro has a tool for sending emails with several options for attachments directly from the software. You must fill in the From Email Address and the Sender Full Name, you can add recipients on the right and select the attachment at the bottom, and of course there is an area to type a message.

To send a message, select one or more recipients, optionally select an attachment, type a message, and click **Send**.
Sending Bulk Emails

Selecting Emails from the File menu displays Emails Screen...

There is a sample email in a file samples.txt that is loaded above. You can load it with the Load button.

Along the left side you must configure an SMTP server to send your emails through. You have an SMTP server with whatever email account you have, alternatively your organization may provide an SMTP server, or you can create a gmail account and send through the smtp.gmail.com server as demonstrated above.

Optionally you can set Anti Flood parameters, some ISPs have restrictions on how many emails can be sent at one time. When anti flood is set OrgPro will close the connection after every batch, pause for the specified number of seconds, reopen the connection, and proceed with the next batch. You may or may not need this feature but it's there if you do, anti flood will obviously slow the sending of your messages.
Clicking the **Load** button allows you to load a previously saved email. Emails are saved as text files in the OrgPro/Email folder.

Clicking the **Save** button saves the email as a text file in the Emails folder.

Click the **Browse** button to browse for files to send as attachments to the email. There is a limit of 50K on the file size of attachments.

Clicking the **Test** button sends the email to the address you set in connection parameters as the Return Email Address. This allows you to review it and correct any formatting problems before sending potentially large numbers of Emails.

You can add an attachment to your email, be aware this will slow the sending of your email proportionately to the size of the attachment.

Use this button to remove an attachment.

The **Send** button actually sends the Emails. You will select lists from your mailing lists to determine who an Email actually gets sent to.

After the Emails are sent the **Sent To** box will be populated with the names of the recipients.
To the left is a sample Gmail account setup, if you were using Gmail the only thing you would need to change is the user name (email address) and the password. We're showing anti flood as enabled with 30 in each batch with a 5 second delay between each, whether anti flood is needed for Gmail is unknown, we recommend you only use anti flood with any ISP unless you determine you need it.

**Note:** The password you enter in is encrypted before it is stored.
Another option that you have is to simply specify sportdatainc.com as the out going mail server as shown to the left. All the parameters and options will gray out and the mail will be sent through our mail server.

One consequence of using our email server is that you will lose the ability to add an attachment, to have the attachment capability you must configure your own email server.
Calendar Editor

ShowPro has a Calendar Editor that you can use to manage your show calendar. If you host your web site with us or have the RSMH Server you may be able to use OrgPro to post your calendar to the web site with a single mouse click. When you select Calendars from the File menu the following screen is displayed...

To create a new calendar click the **New** button and edit the name in the edit box. Now you can add shows to your calendar using the **Append** or the **Insert** buttons. You can copy and paste shows using the **Copy Show** and **Paste Show** buttons. Once your calendar is complete it will look like this...
If you are set up to do so you can upload your calendar to your web site by clicking the Upload button. You can view and print your calendar by clicking the View button...
The check box above the upload button controls whether the calendar is displayed on the web site, it enables you to have a calendar not appear on the web site without having to delete it. Unchecking the box makes the calendar disappear from the web site, checking it and then uploading brings it back.

The Up/Down button are in two places, they allow you to change the order entire calendars are displayed in or to change the order shows are displayed within a calendar.

The Remove button appears in two places and is used to either remove an entire calendar or to remove a show from a calendar.

The View button allow you to view the calendar in the report viewer where it can also be printed.

The Upload button uploads the currently selected calendar to the web site assuming you are set up for this.
The **Append** button adds a new show to the bottom of the currently selected calendar.

The **Insert** button inserts a new show before the currently selected show in the currently selected calendar.

The **Upload Document** button allows you to upload a Prize list/Entry Form, Prize List, Entry Form, or Schedule to the web site for the currently selected show.

The **Remove Document(s)** button allows you to remove a selected document for the selected show, all documents for the selected show, or all documents for all calendars.

The **Toggle Canceled** button allows you to indicate that a show is canceled. A canceled show will appear in red on the web site with " - Canceled" after it's name. It will also appear in red in the shows table so that you can see that it is flagged as canceled.

The **Copy Show** button copies the currently selected show to a buffer so that it can be pasted into another show which is a big time saver as shows tend to have duplicated contact parameters.

The **Paste Show** button works with the Copy Show Button, it's used to paste the copied show.

**Note**

The shows table has a * column, checking the box for this column will add a * next to the show and the *Note is added at the bottom of the calendar(s). This can be used to indicate anything you want, final approval is pending, results have been posted, etc. This is of course optional and you can choose to not use it at all.

**General Note**

This allows you to add a general note at the bottom of the calendar, again optional.

**Revised Note**

This will be appended to the title of the calendar, it allows you to control the reporting of when the calendar was last updated. You would put text in here similar to: **Updated: October 13, 2016.**

**Hscom**

The Hscom column in the shows table makes it easy to add a link to the show on www.Horseshowing.com, each show on Horseshowing.com has it's own page, if you pull up that page the address bar in the browser will look something like this...

```
http://www.horseshowing.com/show.php?show=3988
```

All you have to do is put the 4 digit number on the end of the address (in this case 3988) in the Hscom column for the show.
The **X** column on the show allows you to exclude a show from the web site, it is **excluded if the box is checked**. This is extremely handy if you're editing last years calendar for this year and you don't want the show on there but you don't want to delete it either because you feel eventually it will be appropriate for it to be there.
When you process or print cards or labels you will first see the **Label Options Dialog**.

This dialog allows you to select the label media. OrgPro comes configured for Avery 5160 2.63" x 1 (3 across) and Avery 5161, 4"X1" (2 across) laser and ink jet labels.

OrgPro also supports Avery business card stock for member and recording cards. These cards come in sheets and you can have them custom printed with your organization's logo, address, phone number, and web site URL. OrgPro will print the member/horse information on the bottom portion of the card.

You can also configure virtually any other label by clicking the **New Label** button and entering in the parameters that define the labels...
MS Word is a handy reference for label parameters. You'll find that the MS Word label parameter handling is very similar to what is in OrgPro.

This shows a configuration for Avery 5160 which is a common three across ten down label that is particularly well suited for mailing labels.

In This Chapter

Member and Recording Cards............................................123
Mailing Labels....................................................................126
Member and Recording Cards
You have the option to print single cards, which may occasionally be necessary, or to process cards, which is to process many cards in a batch. You will probably more often process cards in a batch.

In either case you will first be prompted to select a printer...

The idea being that you may have a dedicated printer loaded with card stock, if you're using the same printer for everything you'll need to load it with your card stock.

Next you'll be prompted to set a start and end date, members with paid dates between these dates that do not have the Card Issued flag set will have a card printed...

Next the Label Print Manager will be displayed which shows you what cards will be printed and allows you to set the start column and row and to specify where in the list the printing should begin. If your list is quite long you may want to start somewhere toward the bottom of the list, this way you can process only a few sheets of card stock at a time, minimizing the chance of a paper jam...
In either case you will first be presented with the **Label Options Dialog**.

Select **Dot matrix** or **Laser and ink jet** and select the **Label product**. Then click **Ok**.

The Label Print Manager will then appear in one of several forms.

If your using a laser or ink jet printer you will be able to set the column and row where the printing will start. This allows you to use partial sheets of labels and avoids wasting any. You can also select from the list where the printing should start. If you are using card stock, there are ten labels on each sheet. You can select the 10th, or 20th label from the **bottom**, again avoiding wasting any labels.

When you click **Start**, your cards will begin printing.
Mailing Labels

You have the option to print a single mailing label, which may occasionally be necessary, or to process mailing labels, which is to process many in a batch.

In either case you will first be presented with the Label Options Dialog.

Select Dot matrix or Laser and ink jet and select the Label product. Then click Ok.

The Select Lists dialog will appear.

Select the lists that you would like to include. One label will be printed if a person is subscribed to any of the selected lists. If you click Members Only, only paid members will be included in the list. When you have made your selections, click OK.
Next you'll have an opportunity to sort the labels by zip code or alphabetically and also the option to write the data to a .CSV (comma separated values file) rather than print it on labels.

If you opt to print to the labels the Label Print Manager will then appear in one of several forms.

If your using a laser or ink jet printer you will be able to set the column and row where the printing will start. This allows you to use partial sheets of labels and avoids wasting any. You can also select from the list where the printing should start.

When you click **Start**, your labels will begin printing.
OrgPro and ShowPro are inherently compatible and have the ability to trade data back and forth. Specifically, everything about your organization can be exported from OrgPro to be imported into ShowPro. This includes the show types, member types, sections, and everything that defines your organization, plus the people and horses.

This removes a tremendous burden from the show secretary using ShowPro because all that is required is to enter the horses recording number or type in their name and most of the information for the entry is instantly on the entry.

And, show results from ShowPro, or USEF electronic results, can be imported which in turn can instantly update point standings.

In This Chapter

Exporting Organization Data..............................................130
Importing Show Data ........................................................132
Importing Joined At Show .................................................133
Importing USEF Results.....................................................136
USEF Name Mapping Tokens.............................................139
Exporting Organization Data

There are at least a couple reason why you would want to share organization data...

- With ShowPro users to enable them to send you high quality electronic results thay you can import.
- With another OrgPro user functioning as a points secretary when you are the membership secretary.

There are also several options for exporting organization data...

- If you have an RSMH Server through Upload Management (the easiest/best option in most cases).
- To files if you don't have Upload Management available.
- Through the Email Tool.

The Email Tool allows you to restrict the data export to a specified mile raadius around a central zip code which is useful for national or perhaps state wide organizations - there's no reason to send a broader scope of data then is required for a show to be able to submit good quality results.

There is an option in File > Preferences to allow you to restrict data export to names and organization numbers only, horses shows that you sanction would of course like to have the contact information but you may not want to provide it.

To export organization data to a file, click Export > Org Data on the Tools menu and the following standard file save dialog will be displayed....
You can navigate to a memory stick or save the file on your hard drive to be e mailed or copied to another location at a later time.

OrgPro will name your export file using your organization's acronym with a .ZIP extension. The export file is a standard compressed zip file.

When you have set the location, click **Save**.
Importing Show Data

To import show data from ShowPro, click **Import > Results From ShowPro** on the **Tools** menu and the following standard Windows file open dialog will be displayed...

You can navigate to a memory stick or open a file on your hard drive. ShowPro names the exported shows using the date of, and the name of the show.

When you have selected a show, click **Open**.

After you import a show it will appear on your **Points Screen**.
Importing Joined At Show
Note: This feature is supported only if OrgPro is set to assign membership and recording numbers automatically. Currently this feature is not supported if members or horses are set to join on an individual section basis, this limitation may be addressed in a future release.

OrgPro has the ability to import from ShowPro people that joined at the show and horses that were recorded at the show. ShowPro has a facility to allow the show secretary to flag these people and horses on a per organization basis and to export them along with the results. Importing this data in has the potential to save the organizations membership secretary a considerable amount of work.

OrgPro has a powerful tool to for the membership secretary to use that ensures that the data is imported as intended. To use this tool select **Import Joined At Show** from the **Data** menu.

If you do you just need to read the message and make the appropriate decision. Through out this entire process OrgPro will be looking out for your interests and doing everything possible to prevent a mistake from being made.

Note: When you're performing this process you should have the paper membership and recording forms to refer to for validation of the information that is being imported.

The importer tool has three tabs. The first tab has people that joined and may or may not have horses associated with them that were also recorded at the show. One thing that the importer is going to do is keep horses associated with their owners as OrgPro requires. The first tab will look something like this...

![Image of the Import Joined At Show People/Horses window]

The selected person has a horse associated with them that was recored at the show. Note that the person has an existing member number, this is a renewal. Note that the horse does not have a recording number, this is a new recording.

There are three buttons at the bottom, these buttons cause persons and horses to be moved to the **People / Horses Ready to Import** tab. They do not cause any actual importing to occur, the importing is done in a final step.

The **Import Person / All Horses** button is not available because the person only has one horse associated with them. If they had more than one horse it would be available as a convenience to allow you to move all the horses to the **Horses Ready to Import** tab.

The **Import Person / Horse** button is available and is almost certainly the button you would use in this...
HUAM Annual

J o i n e d A t S h o w

2 Oct 2007  8:02 AM

Members
Chris Braeutigam (Renewal: 202)
Eleanor Feitner (Renewal: 525)
Katie Nowak (Renewal: 660)
Maria L. Yzerman (New Member: 710)
Megan Ward (Renewal: 699)
Pamela Greve (Renewal: 226)
Sharrone Peters (Renewal: 326)
Travis Lingenfelter (Renewal: 175)
Victoria Czaplicka (Renewal: 637)

Horses
Adlingen's Moonlight Safari/Diane Sheets (Renewal: 1254)
Asheville/Monica Murphy (New Recording: 1948)
Bailey/Pamela Greve (Renewal: 1256)
By Invitation Only/Travis Lingenfelter (New Recording: 1949)
Cabeza Roja/Sharrone Peters (New Recording: 1950)
Happy Hour/Kathryn Rado (New Recording: 1951)
Mark My Word/Maria L. Yzerman (New Recording: 1952)
Oberon/Nicole Doss (New Recording: 1953)
Importing USEF Results

OrgPro can import the latest USEF electronic results format but to get the most out of it you should set up mappings of the USEF section codes to the sections that your organization recognizes. Once you have this set up you can import the USEF electronic format very easily. You can also enter in the USEF numbers for your members and horses. If you have USEF numbers entered they will be mapped to your organization numbers and the members and horses will be recognized and points will be assigned appropriately. Members and horses that do not have USEF numbers entered will have to be resolved using the Update Show Points (see "Using Update Show Points/Refresh Points" on page 94) function.

To set up your section code mappings select **USEF Section Codes Maps** from the **Data** menu, the following dialog is displayed...
It is just a matter of setting the appropriate section code from your organization for each USEF section code. Above Pony Hunter for S,M, and L are being mapped to code 31, no doubt Pony Hunter.

The other important thing you can have in place is the USEF numbers of the members and the horses. These are mapped to the membership and recording numbers of your organization and allow points to be directly assigned when the USEF electronic results are imported. If you don't have USEF numbers for all your members and horses the Update Show Points feature can be used to assign the points but it will make your job a little easier if you have these USEF numbers in place.

To import the the USEF electronic results simply select Import USEF Electronic Results from the Tools > Import menu and navigate to and open the file. You should definitely always make a backup of your OrgPro database before importing USEF electronic results, a file that is not in the correct format could potentially damage your data. OrgPro can open comma delimited (CSV) or tab delimited files. If you receive an Excel (XLS) file you should open it in Excel and save the file as a tab delimited text file. If you do not have the Excel program you should request the sender of the file to resend it as a tab delimited text file.

When you open the file it will be displayed in a table as show below. This gives you an opportunity to access the validity of the file and to make some corrections if they are required.

The rows below that are highlighted in green are championships. OrgPro has recognized them as championships because the class number is greater than 10000 and because the word "Championship" appears in the class name. These are two methods that USEF uses to recognize championships. A couple other variations are also recognized by OrgPro - the word "Division" in the class name or and X appearing in the class number, i.e. 101X - we have seen files that use these conventions.

You can use the Toggle Championship button to change whether a line in the file represents a championship or not, this give you the ability to control what is interpreted as a championship.

If you click Ok the results will be imported into OrgPro, if you click Cancel they will not be imported.
You can select multiple rows in the table by dragging your mouse down any column, if any column is selected that entire row is selected. You can delete the selected row(s) or toggle the championship status.
USEF Name Mapping Tokens

When USEF results are imported codes are assigned through section code mappings where possible. Unfortunately classes can come in with either a blank code or a miscellaneous code which isn't any help for code mapping. To help this situation OrgPro allows you to set up tokens and associate them with a code that should be assigned...

You enter a set of tokens separated by commas and the code that should be used if ALL the tokens are found in the class name.

Tokens can be partial words, there's no need to type "working" or "hunter", "wor" and "hun" will suffice to make a match.

Using USEF Name Mapping Tokens can dramatically increase the number of classes that are mapped to codes with a corresponding reduction in points processing effort.
CHAPTER 12

Registering OrgPro

The demo version of OrgPro is the full version but will only allow you to import one show. To have the full use of the program requires that you purchase a subscription at www.sportdatainc.com by logging into your account.

To register your copy of OrgPro™, click on the License Manager menu item that appears on the File menu.

This will cause the License Manager to be displayed...
The License Manager is used to manage your OrgPro software license...

To register a license on your computer from your account on www.sportdatainc.com.

To remove your license from the computer which will restore the license into your account on www.sportdatainc.com making it available to be registered on a different computer.

**Note:** It is very important that before uninstalling the software for any reason, or taking the computer in for service, that you remove the license from the computer first and restore it into your account on www.sportdatainc.com.

To register OrgPro™, click the **Register** button on the **License Manager** dialog, you will be prompted to log into your account and your subscription will be acquired.

The **Remove** button is used to remove the license from the computer system. This will cause the software to revert to the demo. The removed license will be restored into your account on www.sportdatainc.com allowing it to be registered on a different computer, perhaps a newly purchased one.
Index

C
Calendar Editor • 115
Categories • 28, 40
Class Judges • 97
Configuring Web Upload • 101
Creating a Show • 75, 91

D
Divisions • 22
Downloading Org Data • 107

E
Edit Defined Names • 53
Email • 109
Email Tool • 110
Exporting Organization Data • 130

G
Getting Started • 13

H
High Points • 44
Horses Screen Features • 67

I
Import/Export • 129
Importing Joined At Show • 133
Importing Show Data • 132
Importing USEF Results • 136
Introduction • 5

L
Labels and Cards • 121
Locations • 26

M
Mailing Labels • 126
Mailing Lists • 47
Medal Qualification • 35, 39
Member and Recording Cards • 123
Member Types • 27
Members Screen Features • 58

O
Overview • 7

P
Points System • 37
Points Tables • 30

R
Ratings • 29
Registering OrgPro • 141
Reports • 99
RSMH Server • 101

S
Searching For Member And Horses • 73
Sections • 24
Sending Bulk Emails • 111
Show Seasons • 18
Show Types • 20
Support • 5

T
The Horses Menu • 71
The Horses Screen • 65
The Members Menu • 62
The Members Screen • 55
The Points Screen • 83
Trainers • 49
Typographical Conventions • 6

U
Upload Management • 104
Uploading Org data • 106
Uploading RSMH Data • 102
USEF Name Mapping Tokens • 139
Using the Create Show Page • 79
Using The Points Screen • 85
Using Update Show Points/Refresh Points • 87, 94, 136
Where Are The Files • 12
Working With List Editors • 9, 20, 22, 24, 26, 28, 29, 35